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Experiment No. 1 

Title: Differentiation between System Software and Application Software 

 

Aim: 

To understand the concept of system software and application software and to differentiate 

between them based on their functions, features, and usage. 

 

Theory: 

A computer system requires different types of software to function properly. Software can be 

broadly classified into system software and application software. 

System Software is a type of software designed to manage and control the hardware 

components of a computer. It acts as an interface between the user and the hardware. It provides 

a platform for running application software. Examples include operating systems, device 

drivers, and utility programs. 

Application Software is designed to help users perform specific tasks such as writing 

documents, making calculations, browsing the internet, etc. These programs run on top of 

system software and depend on it for execution. 

 

Procedure: 

1. Studied the definitions of system software and application software from textbooks and 

online resources. 

2. Identified different types of system software such as operating systems, device drivers, 

and utility programs. 

3. Listed examples of system software like Windows, Linux, antivirus software, and disk 

management tools. 

4. Identified various types of application software used for daily tasks. 

5. Listed examples of application software such as MS Word, MS Excel, web browsers, 

media players, etc. 

6. Compared both types of software based on parameters like purpose, functionality, 

dependency, and user interaction. 

7. Prepared a comparison table to clearly show the differences. 
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Observation / Comparison Table: 

Basis System Software Application Software 

Definition Controls and manages hardware Performs specific user tasks 

Purpose Provides platform for applications Helps user perform tasks 

Dependency Independent of application software Depends on system software 

Interaction Works in background Directly interacts with user 

Examples Windows, Linux, Device Drivers MS Word, Excel, Chrome 

Installation Installed before application software Installed after system software 

 

Result: 

The difference between system software and application software was successfully studied and 

understood. A clear comparison was made based on their functions, purpose, and examples. 

 

Conclusion: 

System software is essential for the functioning of a computer as it manages hardware and 

provides a platform for application software. Application software, on the other hand, helps 

users perform specific tasks. Both types of software are important and work together for 

efficient computer operation. 
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Experiment No. 2 

Title: To Perform Document Creation, Editing and formatting using MS Word 

 

Aim  

1. Getting used to the Graphical User Interface (GUI) of Windows Operating Systems.  

2. Understanding how word processors work and developing the ability to create various types  

    of documents using Microsoft Word 2007.  

 

Preliminary Explanations  

Word processors are the programs that are used to create, edit, print and save documents. It is 

possible to create reports, papers, announcements or even books using a word processor. This 

week we will be experimenting with Microsoft Word 2007. Since this program has many 

features, it is not possible to cover all topics. However, after this experiment, you will be able 

to use most required functionality. Other features can be learned using the “Help” menu.  

 

Writing Text  

When you open Microsoft Word, a new blank document will be ready for you. You may write 

whatever you like on this page. Anything you write will be displayed on the screen. Note: Use 

the enter key to create new paragraphs; not to end sentences or lines.  

Text Selection  

Using Mouse  

1. Position your mouse cursor over the beginning of the text you want to select.  

 

2. Holding the left mouse button, move the mouse button to the end of the text  

 

3. Release the left mouse button  

 

Using Keyboard  

1. Position the text cursor (blinking line) to the beginning of the text using direction 

keys on your keyboard,  

 

2. Holding the Shift button, go to the end of the text you want to select, again use  

direction keys to move. 
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3. Release the Shift key. After text selection, you may perform various operations. For 

instance, you may copy the text and paste it somewhere, make it bold, change its 

size, font or color. 

 

Cut, Copy and Paste  

You should select a text to copy or cut it. After selection you can use either “Copy” (CTRL + 

C) or “Cut” (CTRL + X) command. You can access these commands from the menu shown in 

Figure 1 You may use cut operation to move the text and copy to duplicate it. After issuing one 

of these commands, place text cursor to the place you want and issue “Paste” (CTRL + V) 

command.  

Note: You may paste a copied text as much as you like. 

Use of Menus  

In the figure below the main menu commands are shown. Details of these commands are given 

in the following chapters. 

 

 

 

 

 

 

 

 

 

 

 

Figure 1: Main menu 

On the top of the screen, there is a bar where the menus (Home, Insert, Page layout, etc...) are 

located. You may perform many operations using these menus. It is impossible to cover all 

menu functionality in one experiment; however, you may try to learn these uncovered 

functionality in your free time. Help Menu is the best source of information. You may access 

to help menu using symbol (     ) located on the menu bar.  

You may access File menu from the top left corner of the screen using (      ) symbol. The 

“New” command in this menu creates a new empty document. You may load a previously 

saved document using “Open” command. “Save” command is used to save your document. 

You may use “Save as” command to save your document with a different name. “Close” 
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command will close active document. While the office menu is open, recently used files will 

be listed on the right. You may also open the document you want from this list by clicking on 

it. You can also save your document using the disk           button. To undo an operation that 

you do, you can use back arrow icon          which is located next to disk icon. 

Changing Font Type and Font Size  

In Microsoft Word 2007 starting font is Calibri with the size of 11 points. You can change the 

font type and size using the “Font type” and “Font size” sections, which are shown in Figure 1 

Ready to use styles are located on the right side of the main menu and can be helpful for this 

matter. In fact, its advised to use these styles for headers.  

Example:  

This sentence is written with size 8. This sentence is written with size 

16.  

Usually “Times New Roman” is preferred in academic papers. This document is also written 

in “Times New Roman” font type. If you wish to place program codes in your document, using 

“Courier New” type fonts will make them more readable:  

Example  

int main() { 

         return 0;  

            }  

When necessary, you may make a part of you text bold, italic or underline. In general you 

should make keywords in your document bold. Italic is used emphasize the importance of 

words. In English underline is not commonly used. These styles can be used together as well.  

Example:  

Which of the following is not an input/output unit.  

This text is both italic and bold.  

Using alignment buttons shown in Figure 1 you may change the alignments of paragraphs. The 

alignment types are “Left aligned”, “Right Aligned”, “Centered”, and “Justified”. Justified 

aligns both sides of the text to the document.  

You may use “Margins” button from the “Page layout” menu to adjust margins of your 

document. There some ready options in this list, however, you are allowed to customize 

margins using “Customize margins” option. If you are required to divide your document into 

columns, you may use “Columns” button from the “Page layout” menu. You may select a ready 

option or design your own column system using “More columns” option. 
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Using Shortcut and Access Keys  

Many of the menu commands can be accessed using a keyboard shortcut. Shortcuts can be used 

instead of clicking to speed up your work. For instance, instead of using save button from the 

toolbar, you can use CTRL + S key combination. To do that, press S key while pressing Ctrl 

key.  

The following is the list of most used shortcuts:  

CTRL + C: Copy  

CTRL + X: Cut  

CTRL + V: Paste  

CTRL + Z: Undo  

CTRL + S: Save  

CTRL + P: Print  

When you press Alt key, some letters will be shown on menu items. You may press these keys 

while holding Alt key to perform the operation you want. 

 

Tables  

To insert a table you can use “Table” button from the Insert menu. After clicking this button 

select number of rows and columns. This operation will create a new table. You may use TAB 

key to move between t he cells of your table. If you press TAB in the last line, a new 

line will automatically be inserted for you. You may exercise by creating the table below. 

 

 

 

 

 

 

You can use “Design” menu to adjust a table. You must select a table to see Design menu. 

Similarly you can change row and column data using “Layout” menu. 

 

Experimental Work   

1. Start the Microsoft Word by finding it from the Start menu. Please type in the first 

paragraph of Preliminary Explanations section and duplicate this paragraph for five 

times. You should make copies in separate paragraphs. 
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 Use “Times New Roman” sized 12 points.  

 Underline all “word processor” texts  

 Make all “this” and “and” words bold   

 Change font type of “Microsoft Word 2007” to “Courier new”.  

 Change the size of “help” word to 16 points.  

2. Change the alignments of these paragraphs.  

3. Create a table containing student number, name, surname and age. These headers 

should be in the first row, make them bold. Enter your own information to second, and 

information of your friend to the third.  

4. Recreate all the equations within this document. 
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Experiment No. 3 

Title: Data Manipulation using MS Excel 

 

Preliminary Explanations  

Spreadsheets help us with poll results analyzing, statistical summary creation, financial 

decision making, and accounting. This week will be working on Microsoft Excel 2007. Since 

this application has many functionalities, it is not possible to cover all in a single experiment; 

however, after this lab session, you will be completed most common tasks. More importantly, 

you will be able to learn other features using the help menu.  

After you start Excel, a new worksheet will be waiting for you. This worksheet is divided into 

cells like a table. Columns are addressed by numbers (1, 2, 3...) while columns are addressed 

by letters (A, B, C...). On the other hand, cells are address with a letter and a number (A1, B7, 

Z44). You may enter, text, numeric value or formulas to these cells. The text you have entered 

will act as labels whereas the numbers will be your data. The formula you have entered will 

calculate the result you wanted. 

 

Ranges  

In Microsoft Excel, a range is a rectangular region. A range is defined using its cell addresses 

of their opposing cells. Ranges are used in operations such as summation and averaging.  

Example:  

A1:A5 Addresses the first five cells of A column and it contains A1, A2, A3, A4 and A5 B2:E3 

contains B2, B3, C2, C3, D2, D3, E2, E3 

 

Formatting  

You may need to change the format of the worksheets you have prepared for printing or 

viewing. 

There are two types of formatting: cell formatting and data formatting. To begin formatting 

you should select the cells you wish to format. There are ready-to-use cell formats located in 

the “Home” menu, under the “Cell styles” section, you can either use these or create your own 

style using “Font” section. If you wish to change the size of columns or rows, you can use the 

ruler that shows column and row addresses. Position your mouse cursor between two row or 

columns and hold left mouse button, moving the mouse will change the width or height of the 

cell. Release the mouse button after you are done. “Home” menu contains “Number” section 

for you to change number format. You may use the list on this section to choose an item from 
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it. In this list, previews of the number formats are shown below. If the formatting you require 

does not exist in the list, you may click “More number formats” item to form the format you 

wish. Moreover, this number section contains buttons to control the decimal digits to be shown  

  

 

Formulas  

In Excel, you can assign formulas to cells instead of simple values. The result of a formula is 

dynamically calculated and shown in the cell you have entered the formula in. For instance: 

you may sum the value of cells F1, F2, and F3 and display in F4 using the formula =F1+F2+F3. 

You only need to start with “=” symbol to create a formula. 

 

Functions  

You may use functions in your formula. Some of these functions work with ranges. If we want 

to rewrite the previously given sample we can use SUM function to obtain same result using 

=SUM(F1:F3). If you want to see the list of all defined functions you can use the “Insert 

function” button (fx). The following is the list of most commonly used functions.  

• SUM: Sums all the values in the given range  

• AVERAGE: Takes the average of the numbers in the given range  

• MIN, MAX: Finds maximum or minimum value in the given range.  

• SUBSTITUTE: Substitutes all occurrences of the second parameter with the third 

parameter in the first parameter. Ex: SUBSTITUTE(F1, "one", "two")  

• POWER: Finds the power of the first parameter to the second one. Ex: POWER(F1, 

2)  

 

Moving and Copying Formulas  

If you move or copy a formula, the addresses or range information inside the formula is also 

changed. For instance, if you move =SUM(F1:F3) formula in the F4 to cell E6, the formula 

will automatically become =SUM(E3:E5). 

 If you do not want the formulas you copy to change, you can use “$” symbol in your cell or 

range addresses. You can use this symbol either for column, row or for both. If you alter the 

previous formula to =SUM($F$1:$F$3) it will not change when you move it. 
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Data  

In Microsoft Excel, there are tools that help you to work with data sets. These tools are located 

in “Data” menu. The most basic functionality in here is sorting and filtering. Using these tools, 

you can easily find the record you search, even in crowded documents. For instance, you can 

easily filter your customers to see who is living in “Magusa”. Similarly you can sort your 

customers by the products they buy to see who are buying more. These operations treat your 

data in rows, therefore you need to organize your data as such.  

To sort the data you have, you can use the sort button located in “Data” menu. After selecting 

your data, click on one of these buttons. A dialog will appear which allows you to choose how 

to sort the selected data.  

Filtering data requires data processing mode to be activated. You can activate this mode by 

selecting your data and clicking “Filter” button. This operation will consider first row you have 

selected as captions. If you do not have a header row, you should add one before starting data 

processing mode. The captions located in the header row defines your column information 

(Customer name, sales, etc...). When data processing mode starts, Excel will assign drop down 

icons to each column. When you click on this symbol a menu containing filtering and sorting 

tools will appear. You may filter your data using this column operations menu. Microsoft Excel 

will produce some automatic filters for you. These filters are generated with regards to the data 

entered to that column. For instance, if your column contains date information, generated filters 

will contain years, months and days in a tree fashion. From this list you can easily select a 

month or the days you want to see. If this list does not contain the filter that you want to use, 

you can also create the filter you want. You may learn the details of this operation from the 

help menu. Apart from filtering, its possible to sort data in data processing mode. 

 

Charts  

To insert a chart, first select the data you need. You need to select a caption row and a caption 

column. For instance, let’s assume that column A contains dates and column B contains the 

sales in those dates. To create the sales chart, firstly add “Dates” to the top of column A and 

“Sales” to the top of column B. Then, select both columns. If it is desired, multiple columns 

can be shown in the same chart. Total price can be added to the previous sample. Similarly, 

this column should have a caption and should be selected. After selecting data go to “Insert” 

menu, click the chart type you want to add and select the subtype from the list, your chart will 

be placed on your worksheet.  

After adding the chart, you may select it to access its properties. Selecting the chart will activate 

“Design”, “Layout” and “Format” menus. In “Design” menu, “Chart layout” section contains 

presets that changes the legend and location of the data labels. The “Chart design” section 

contains preset formats that change chart options such as color and shades. You may also use 

“Layout” and “Format” menus control layout and format options by yourself. Note: To select 

non-sequential data, select the first area then hold CTRL button and select the second area. 



  

LAB COURSE ON IT | SNJB Chandwad Page 11 

Experimental Work  

1. Prepare the following table, try to modify your table to look like the given sample below. 

 

 

  

 

 

 

 

 

 

 

2. In the row containing CMPE 101, add the formula that calculates the multiplication of 

“Credits” and “Value” columns to the “Credits earned” column. The result should be 16.  

3. Copy the formula you have prepared in step 2 to other course rows. The values displayed 

should be: 12, 13.2, 10.8 and 11.1  

4. Write the formula that calculates the total credits earned next to the “Total credits earned” 

label. The value should be 63.1.  

5. Write the formula that calculates the total credits of the courses to the respected cell. This 

value should be 19.  

6. Use the following formula to calculate the average. The correct result of this formula should 

be 3,3210526. 

 

 

 

7. Adjust the GPA cell to show only two digits after decimal separator (result: 3.32)  

8. Change CMPE 101 to A and its value to 4, and follow the changes.  

9. Sort the courses table according to value column. You may refer to Section named.  

10. Add a pie chart to your worksheet that shows the contribution ratio of every course. To do 

this you have to create your chart from course names (including the header) and credits earned 

column. Modify your chart to look like the one given on the next page.  
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11. Filter your courses table to show courses that have credit value of 4. You may refer to the 

section . 
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Experiment No. 4 

Title: Presentation Design using MS PowerPoint 

 

Aim: 

To create an effective and visually appealing presentation using MS PowerPoint and 

understand its features. 

 

Theory: 

Microsoft PowerPoint is a widely used application for creating visual presentations. It 

allows users to present information in the form of slides, which can include text, images, 

charts, audio, and video. 

PowerPoint provides various tools such as themes, templates, slide layouts, animations, and 

transitions that enhance the visual appeal and effectiveness of presentations. It is commonly 

used in education, business meetings, seminars, and conferences to communicate ideas 

clearly and professionally. 

 

Procedure: 

1. Switched on the computer and opened Microsoft PowerPoint. 

2. Selected Blank Presentation or a suitable template. 

3. Created a title slide by adding presentation title and subtitle. 

4. Inserted new slides and added relevant content (headings, bullet points). 

5. Applied suitable themes and slide layouts. 

6. Inserted images, shapes, and SmartArt. 

7. Added charts or graphs if required. 

8. Inserted multimedia elements (audio/video). 

9. Applied animations and slide transitions. 

10. Previewed the presentation using Slide Show. 

11. Saved the presentation. 
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Sample Slide Content: 

Slide 1: Title Slide 

 Title: Importance of Information Technology 

 Subtitle: Presented by [Student Name] 

 Class/Roll No.: [Details] 

 

Slide 2: Introduction 

 Information Technology (IT) refers to the use of computers and software to manage 

information. 

 IT plays a vital role in modern society. 

 

Slide 3: Uses of IT 

 Communication (Email, Video Calls) 

 Education (Online Learning) 

 Banking (Online Transactions) 

 Healthcare (Digital Records) 

 

Slide 4: Advantages of IT 

 Fast communication 

 Easy data storage 

 Improved efficiency 

 Global connectivity 

 

Slide 5: Disadvantages of IT 

 Cybersecurity risks 

 Privacy concerns 

 Dependency on technology 

 

Slide 6: Conclusion 

 IT is essential in today’s world. 

 It improves productivity but must be used responsibly. 
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Observation: 

 Themes improved visual consistency. 

 Multimedia made slides engaging. 

 Animations enhanced presentation quality. 

 

Result: 

An effective and well-designed presentation was successfully created. 

 

Conclusion: 

MS PowerPoint helps in presenting information clearly and attractively using visual elements 

and multimedia tools. 
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Experiment No. 5 

Title: Explore antivirus software for maintaining computer security.

 

Understanding Antivirus Software: 

Antivirus software, also known as anti-malware, is a fundamental security tool that acts as a 

guardian for your digital information. It shields your devices from a wide range of malicious 

threats, including viruses, malware, ransomware, and other cyberattacks. By proactively 

preventing these threats from infiltrating your system, antivirus software plays a crucial role in 

maintaining the safety and integrity of your data. 

What is Antivirus Software? 

Antivirus software, as we saw in the introduction, acts as a digital shield, safeguarding your 

devices and data from a constantly evolving landscape of malicious threats. Let’s delve deeper 

into its core functionalities and how it accomplishes this critical task. 

Components and Functionalities: 

Virus Scanners: These scan your system for malicious code patterns based on definitions stored 

in a virus database. Regularly updated databases are essential for antivirus software to stay 

effective against new threats. 

Real-time Protection: This monitors system activity in real-time, scrutinizing files, 

applications, and network traffic to identify and block potential attacks before they can harm 

your device. 

Behavior-Based Detection: Modern antivirus programs go beyond simple pattern matching and 

employ behavior-based detection to identify suspicious activities, even if the specific malware 

is unknown. This helps combat zero-day attacks, which exploit previously undiscovered 

vulnerabilities. 

Quarantine and Removal: If malware is detected, the antivirus software can quarantine it, 

preventing it from spreading or causing damage. In some cases, it may also attempt to remove 

the malware entirely. 

 

Importance in Cybersecurity: 

The internet can be a minefield of security threats. Malicious software, often shortened to 

malware, encompasses a broad spectrum of harmful programs, including viruses, worms, 

Trojan horses, ransomware, and spyware. These programs can steal your personal information, 

encrypt your data for ransom, damage your system, or even spy on your online activity. 
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Antivirus software plays a vital role in your cybersecurity defense by: 

Preventing Infections: By proactively scanning for and blocking malware, it stops threats 

before they can establish a foothold in your system. 

Minimizing Damage: Even if an infection occurs, real-time protection can limit the damage by 

catching it early and containing the spread. 

Safeguarding Data: Antivirus software helps protect your sensitive information, such as 

financial data, passwords, and personal documents, from theft or corruption. 

 

Evolution and Importance in Security Strategy: 

Antivirus software has come a long way since its initial focus on simple virus detection. Today, 

it’s a constantly evolving shield adapting to new threats and employing advanced techniques. 

This ongoing evolution underscores the importance of antivirus software as a foundational 

component of a comprehensive security strategy. 

In the next section, we’ll explore the different types of antivirus software available and how to 

choose the right one for your needs. 

What Does Antivirus Software Do? 

Antivirus software acts as a vigilant guardian for your digital life, offering a multi-pronged 

approach to protect your devices and data from malicious threats. Let’s explore its core 

functions in detail: 

1. Malware Removal and Prevention: 

Scanning: Antivirus software scans your system for malware, including viruses, worms, Trojan 

horses, spyware, and ransomware. These scans can be: 

Scheduled Scans: Run automatically at regular intervals to proactively identify threats. 

On-Demand Scans: Initiated manually by the user to scan specific files or folders. 

Real-time Scans: Continuously monitor system activity, scrutinizing files, applications, and 

network traffic to identify threats in real-time. 

Detection: Antivirus software uses two primary methods to detect malware: 

Signature-based Detection: Compares file patterns to a database of known malware signatures. 

This method is highly effective against established threats. 

Behavior-based Detection: Analyzes program behavior to identify suspicious activities, even 

if the specific malware is unknown. This helps combat zero-day attacks, which exploit 

previously undiscovered vulnerabilities.  

https://www.ericom.com/secure-web-and-internet-access/
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Quarantine and Removal: If malware is detected, the antivirus software can take action by: 

Quarantining: Isolating the infected files to prevent them from spreading or causing further 

damage. 

Removal: Attempting to remove the malware entirely from your system. This process can be 

complex and may require user interaction. 

 2. Threat Detection: 

Email Protection: Scans incoming and outgoing emails for malicious attachments and phishing 

attempts designed to steal personal information. 

Web Protection: Blocks access to known malicious websites and prevents drive-by downloads, 

where malware is automatically downloaded when you visit an infected website. 

Network Intrusion Detection: Monitors network activity for suspicious patterns that might 

indicate an attempted attack. 

 3. Additional Features (may vary by program): 

VPN Services: Encrypt your internet traffic, providing an extra layer of security when using 

public Wi-Fi networks. 

Password Managers: Securely store and manage your passwords for various online accounts. 

Firewall Protection: Monitors incoming and outgoing network traffic, filtering out 

unauthorized access attempts. 

Parental Controls: Help restrict access to inappropriate content and applications for children. 

 

Importance of a Comprehensive Security Strategy: 

While antivirus software is a vital component of cybersecurity, it’s not a foolproof solution. A 

layered approach is essential. Here are some additional security practices to consider: 

Keep Software Updated: Regularly update your operating system, applications, and antivirus 

software to benefit from the latest security patches. 

Practice Safe Browsing: Be cautious when clicking on links or downloading files from 

unknown sources. 

Use Strong Passwords: Avoid easily guessable passwords and consider using a password 

manager. 

Be Wary of Phishing Attempts: Don’t click on suspicious links or attachments in emails, even 

if they appear to be from legitimate sources.  
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By combining a robust antivirus solution with safe browsing habits and a layered security 

approach, you can significantly enhance your online defense and protect your valuable digital 

assets.

 

Antivirus Software Examples: 

In today’s interconnected world, robust antivirus protection is essential for all your devices. 

Here’s a glimpse into some of the well-known antivirus software options, catering to different 

platforms and user needs: 

Windows Antivirus Software: 

Norton 360: A comprehensive security suite offering top-notch virus and malware protection, 

along with features like secure browsing, password management, and parental controls. Ideal 

for users seeking all-in-one protection. 

Bitdefender Antivirus Plus: Known for its excellent threat detection capabilities, user-friendly 

interface, and system performance optimization. A solid choice for users prioritizing core 

antivirus protection with a lightweight feel. 

McAfee Total Protection: Provides multi-device protection alongside antivirus features, 

including identity theft monitoring, safe browsing, and a VPN. Well-suited for users managing 

security across multiple devices. 

 

MacOS Antivirus Software: 

Intego Mac Premium Bundle: Designed specifically for Macs, offering robust protection 

against malware, spyware, and phishing attempts. Includes features like data backup and 

parental controls. A great choice for Mac users seeking comprehensive defense. 

Bitdefender Antivirus for Mac: Leverages Bitdefender’s superior threat detection engine to 

safeguard Macs against malware threats. Offers a user-friendly interface and minimal system 

resource usage. A strong option for Mac users prioritizing core antivirus protection. 

McAfee Endpoint Protection for Mac: Caters to businesses and organizations, offering 

centralized management for Mac security alongside antivirus and anti-theft features. Ideal for 

corporate environments. 

  

Android Antivirus Software: 

Avast Mobile Security: A free and popular option offering malware protection, call blocking, 

and anti-theft features. Well-suited for casual users seeking basic mobile security.  

https://www.ericom.com/platform-overview/
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Bitdefender Mobile Security: Provides excellent malware protection, real-time scanning of 

apps, and web filtering to safeguard against online threats. A strong choice for users prioritizing 

comprehensive mobile security. 

McAfee Mobile Security: Offers antivirus protection, anti-theft features, and app locking to 

secure your personal information. A well-rounded option for mobile security needs. 
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Experiment No. 6 

Report on Applications of Information Technology in Various Sectors 

Introduction 

Information Technology (IT) has become an integral part of modern society. It refers to the use 

of computers, software, networks, and digital systems to store, process, and exchange 

information. Over the past few decades, IT has transformed the way organizations operate and 

deliver services. 

Various sectors such as healthcare, education, banking, and governance have significantly 

benefited from IT. It has improved efficiency, accuracy, accessibility, and communication. 

This report highlights the application and impact of IT in these important sectors. 

 

1. IT in Healthcare Sector 

Information Technology plays a crucial role in improving healthcare services and patient care. 

Applications: 

 Electronic Health Records (EHR): Patient data is stored digitally, making it easy to 

access and update. 

 Telemedicine: Doctors can consult patients remotely through video calls. 

 Medical Imaging: Advanced technologies like MRI and CT scans help in accurate 

diagnosis. 

 Hospital Management Systems: Used for managing appointments, billing, and patient 

records. 

Benefits: 

 Faster diagnosis and treatment 

 Reduced paperwork 

 Improved patient care and safety 

 Easy sharing of medical information 

Example: 

Online doctor consultations and digital prescriptions have become common, especially after 

the COVID-19 pandemic. 
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2. IT in Education Sector 

IT has revolutionized the education system by making learning more interactive and accessible. 

Applications: 

 Online Learning Platforms: Students can attend classes remotely. 

 Digital Classrooms: Use of smart boards and multimedia tools. 

 Learning Management Systems (LMS): Used to manage courses, assignments, and 

assessments. 

 E-books and Digital Libraries: Provide easy access to study materials. 

Benefits: 

 Learning anytime, anywhere 

 Interactive and engaging content 

 Easy access to information 

 Improved communication between teachers and students 

Example: 

Students use online platforms to attend lectures, submit assignments, and take exams digitally. 

 

3. IT in Banking Sector 

The banking sector has undergone major transformation due to IT, making financial services 

faster and more secure. 

Applications: 

 Online Banking: Customers can access accounts and perform transactions anytime. 

 Mobile Banking Apps: Banking services through smartphones. 

 ATM Services: Cash withdrawal and other services without visiting a bank. 

 Digital Payments: UPI, credit/debit cards, and e-wallets. 

Benefits: 

 24/7 banking services 

 Faster transactions 

 Reduced need for physical visits 

 Secure financial operations 

Example: 

Customers can transfer money instantly using mobile apps without visiting a bank branch. 
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4. IT in Governance Sector 

IT has improved the functioning of government services through e-governance. 

Applications: 

 Online Government Services: Application for certificates, licenses, etc. 

 Digital Identity Systems: Online verification of citizens. 

 E-Voting Systems: Electronic voting processes. 

 Public Service Portals: Access to various government schemes and services. 

Benefits: 

 Increased transparency 

 Reduced corruption 

 Faster service delivery 

 Easy access to government services 

Example: 

Citizens can apply for documents like passports, licenses, and certificates online without 

visiting government offices. 

 

Conclusion 

Information Technology has brought significant improvements in various sectors such as 

healthcare, education, banking, and governance. It has made processes faster, more efficient, 

and easily accessible to people. 

With continuous advancements in technology, the role of IT will further expand, leading to 

smarter systems and better services. However, proper security measures and responsible usage 

are essential to maximize its benefits. 
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Experiment No. 7 

Title: Study and Exploration of Government Digital Platform – DigiLocker 

 

Aim: 

To study and explore the features, functions, and usage of DigiLocker as a government digital 

platform. 

 

Theory: 

DigiLocker is a flagship initiative under the Digital India program launched by the 

Government of India. It is a secure cloud-based platform that allows citizens to store, access, 

and share important documents digitally. 

DigiLocker aims to minimize the use of physical documents and provide easy access to official 

records anytime and anywhere. It is linked with Aadhaar and other government databases, 

enabling users to fetch verified documents directly from issuing authorities. 

The platform ensures security, authenticity, and convenience, making it an essential tool for 

digital governance and paperless administration. 

 

Objectives: 

 To understand the concept of digital document storage. 

 To explore the features of DigiLocker. 

 To learn how to access and use government-issued documents online. 

 

Requirements: 

 Computer or smartphone 

 Internet connection 

 Valid mobile number / Aadhaar number 
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Procedure: 

1. Open a web browser and visit the official DigiLocker website or install the DigiLocker 

mobile app. 

2. Click on Sign Up to create a new account. 

3. Enter mobile number and verify using OTP. 

4. Set username and password. 

5. Link Aadhaar number (optional but recommended for full access). 

6. After login, explore the dashboard. 

7. Navigate to Issued Documents to view documents issued by government authorities. 

8. Use Upload Documents option to upload personal files. 

9. Explore Get Documents section to fetch documents like Aadhaar, driving license, mark 

sheets, etc. 

10. Use Share option to send documents digitally via link or email. 

11. Log out after completing the session. 

 

Features of DigiLocker: 

1. Digital Document Storage 

Users can securely store important documents such as Aadhaar card, PAN card, driving license, 

and educational certificates in digital format. 

2. Issued Documents 

Government departments directly issue verified documents to users, eliminating the need for 

physical copies. 

3. Easy Access Anytime 

Documents can be accessed anytime from anywhere using internet-enabled devices. 

4. Secure Platform 

DigiLocker uses secure authentication methods like OTP and Aadhaar verification to ensure 

data safety. 

5. Paperless Governance 

Reduces the use of paper documents and promotes digital transactions. 

6. Document Sharing 

Users can share documents digitally with institutions or authorities without physical 

submission.  
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7. Integration with Government Services 

Connected with multiple government departments like transport, education boards, and UIDAI. 

 

Advantages: 

 Reduces physical document handling 

 Saves time and effort 

 Provides secure storage 

 Ensures authenticity of documents 

 Supports eco-friendly initiatives 

 

Limitations: 

 Requires internet access 

 Limited awareness among users 

 Dependence on digital literacy 

 

Applications: 

 Applying for jobs or admissions 

 Identity verification 

 Government service applications 

 Educational document submission 

 

Observation: 

 DigiLocker provides a simple and user-friendly interface. 

 Documents are easily accessible and shareable. 

 The platform ensures secure handling of personal data. 

 

Result: 

The DigiLocker platform was successfully explored, and its features such as document storage, 

access, and sharing were understood. 
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Conclusion: 

DigiLocker is an effective digital platform that simplifies document management and promotes 

paperless governance. It enhances convenience, security, and accessibility for citizens. With 

increasing adoption, it will play a significant role in India's digital transformation. 
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Experiment No. 8 

Title: Hosting a Session on an Online Meeting Platform (Zoom / Google Meet) 

 

Aim: 

To learn how to host and manage an online meeting session using video conferencing 

platforms. 

 

Theory: 

Online meeting platforms such as Zoom and Google Meet are widely used for virtual 

communication. These platforms allow users to conduct meetings, webinars, online classes, 

and discussions in real-time over the internet. 

They provide features like video conferencing, screen sharing, chat messaging, recording, and 

participant management. These tools are especially useful in education, business, and remote 

work environments. 

With the advancement of Information Technology, online meeting platforms have become 

essential for communication without geographical limitations. 

 

Objectives: 

 To understand the working of online meeting platforms. 

 To learn how to host and manage a meeting session. 

 To explore various features like screen sharing, chat, and recording. 

 

Requirements: 

 Computer/Laptop/Smartphone 

 Internet connection 

 Zoom or Google Meet account 

 Webcam and microphone 
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Procedure: 

Part A: Using Zoom 

1. Open the Zoom application or visit its website. 

2. Sign in using your account credentials. 

3. Click on New Meeting to start an instant meeting. 

4. Allow access to microphone and camera. 

5. Copy the meeting link and share it with participants. 

6. Admit participants from the waiting room. 

7. Use features like: 

o Mute/Unmute participants 

o Turn video on/off 

o Chat with participants 

o Share screen for presentations 

8. Record the meeting (optional). 

9. End the meeting for all participants. 

 

Part B: Using Google Meet 

1. Open Google Meet in a browser or app. 

2. Sign in using a Google account. 

3. Click on New Meeting → Start instant meeting. 

4. Share meeting link with participants. 

5. Allow participants to join. 

6. Use features like: 

o Microphone and camera control 

o Screen sharing (Present Now option) 

o Chat box for communication 

7. End the meeting after completion. 

 

Features of Online Meeting Platforms: 

1. Video Conferencing 

Allows face-to-face interaction through video calls. 

2. Audio Communication 

Enables clear voice communication among participants. 

3. Screen Sharing 

Users can share their screen to present documents, slides, or applications.  
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4. Chat Messaging 

Participants can send messages during the meeting. 

5. Recording Option 

Meetings can be recorded for future reference. 

6. Participant Management 

Host can control participants (mute, remove, admit). 

7. Virtual Backgrounds 

Allows changing background during meetings. 

 

Advantages: 

 Saves travel time and cost 

 Enables communication from any location 

 Supports large number of participants 

 Useful for online classes and meetings 

 Easy to use and accessible 

 

Limitations: 

 Requires stable internet connection 

 Technical issues may occur 

 Security concerns (unauthorized access) 

 Reduced personal interaction 

 

Applications: 

 Online classes and lectures 

 Business meetings 

 Webinars and workshops 

 Remote collaboration 

 

 



  

LAB COURSE ON IT | SNJB Chandwad Page 31 

Observation: 

 The meeting was conducted smoothly with proper audio and video. 

 Screen sharing helped in explaining the content clearly. 

 Chat feature allowed quick communication. 

 Participant management features were effective. 

 

Result: 

An online meeting session was successfully hosted and managed using Zoom/Google Meet 

platform. 

 

Conclusion: 

Online meeting platforms are powerful tools for virtual communication. They provide multiple 

features that make communication efficient, interactive, and accessible from anywhere. These 

platforms are essential in modern education and business environments. 
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Experiment No. 9 

Title: Exploring Educational Platforms – LMS (Moodle / Gnomio) 

 

Aim: 

To explore and understand the features and working of Learning Management Systems (LMS) 

such as Moodle and Gnomio. 

 

Theory: 

A Learning Management System (LMS) is a software application used to manage, deliver, and 

track educational courses and training programs. LMS platforms provide a centralized system 

for teachers and students to interact, share resources, conduct assessments, and monitor 

progress. 

Moodle is one of the most widely used open-source LMS platforms. It allows educators to 

create online courses, upload study materials, assign tasks, and conduct quizzes. 

Gnomio is a free hosting service for Moodle that enables users to create their own Moodle-

based learning environment without installation. 

These platforms are widely used in schools, colleges, and organizations for e-learning and 

distance education. 

 

Objectives: 

 To understand the concept of LMS. 

 To explore features of Moodle and Gnomio. 

 To learn how to access courses and resources online. 

 

Requirements: 

 Computer/Laptop/Smartphone 

 Internet connection 

 Web browser 

 LMS account (Moodle/Gnomio) 
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Procedure: 

Part A: Exploring Moodle 

1. Open a web browser and visit a Moodle-based website. 

2. Click on Login and enter username and password. 

3. After login, observe the dashboard. 

4. Browse available courses. 

5. Select a course and open it. 

6. Access study materials such as notes, PDFs, videos. 

7. Attempt quizzes or assignments (if available). 

8. Check grades and feedback section. 

9. Log out after completion. 

 

Part B: Exploring Gnomio 

1. Visit the Gnomio website. 

2. Create a free LMS site (if required). 

3. Log in to the dashboard. 

4. Create or explore courses. 

5. Upload learning materials (files, videos). 

6. Add assignments or quizzes. 

7. Enroll users (students). 

8. Monitor progress and performance. 

 

Features of LMS (Moodle / Gnomio): 

1. Course Management 

Allows teachers to create and manage courses online. 

2. Content Sharing 

Supports uploading of study materials like PDFs, videos, and presentations. 

3. Assignments and Quizzes 

Teachers can assign tasks and conduct online tests. 

4. User Management 

Allows enrollment of students and role assignment (teacher/student).  
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5. Communication Tools 

Includes forums, messages, and announcements. 

6. Progress Tracking 

Tracks student performance and course completion. 

7. Accessibility 

Students can access courses anytime and anywhere. 

 

Advantages: 

 Supports online and distance learning 

 Easy access to study materials 

 Improves student-teacher interaction 

 Tracks performance efficiently 

 Flexible learning environment 

 

Limitations: 

 Requires internet connectivity 

 Needs basic technical knowledge 

 Limited interaction compared to classroom learning 

 

Applications: 

 Online education in schools and colleges 

 Corporate training programs 

 Skill development courses 

 Distance learning programs 

 

Observation: 

 LMS platforms provide a structured learning environment. 

 Course materials are easily accessible. 

 Assignments and quizzes help in evaluation. 

 Dashboard provides clear overview of progress.  
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Result: 

The LMS platforms Moodle and Gnomio were successfully explored, and their features such 

as course management, content sharing, and assessment were understood. 

 

Conclusion: 

Learning Management Systems like Moodle and Gnomio play an important role in modern 

education by enabling online learning and efficient course management. They provide 

flexibility, accessibility, and effective communication between teachers and students. 
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Experiment No. 10 

Title: Using AI-Based Assistants (ChatGPT and Gemini) to Perform Tasks 

 

Aim: 

To explore and use AI-based assistants like ChatGPT and Gemini for performing various tasks 

such as answering questions, generating content, and problem-solving. 

 

Theory: 

Artificial Intelligence (AI) refers to the simulation of human intelligence in machines that are 

programmed to think, learn, and make decisions. AI-based assistants are advanced software 

tools that use machine learning and natural language processing (NLP) to understand user 

queries and provide relevant responses. 

ChatGPT is an AI-powered conversational assistant that can generate text, answer questions, 

write content, and assist in coding and problem-solving. 

Gemini (developed by Google) is another AI tool that provides intelligent responses, content 

generation, and assistance in various domains. 

These tools are widely used in education, business, research, and daily tasks due to their speed 

and accuracy. 

 

Objectives: 

 To understand the concept of AI-based assistants. 

 To perform different tasks using ChatGPT and Gemini. 

 To analyze the usefulness of AI tools in daily activities. 

 

Requirements: 

 Computer/Laptop/Smartphone 

 Internet connection 

 Web browser 

 Access to ChatGPT and Gemini 
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Procedure: 

Part A: Using ChatGPT 

1. Open a web browser and visit ChatGPT. 

2. Log in or sign up for an account. 

3. Enter a query in the input box (e.g., “Explain Artificial Intelligence”). 

4. Observe the response generated by the AI. 

5. Perform different tasks such as: 

o Writing a paragraph or essay 

o Solving a simple problem 

o Generating code or ideas 

6. Refine queries for better results. 

7. Generate images by providing proper prompt 

8. Can read and analyse the document when uploaded 

9. Save or copy the output. 

 

Part B: Using Gemini 

1. Open the Gemini website or app. 

2. Sign in using a Google account. 

3. Enter queries or tasks in the prompt box. 

4. Analyze the responses generated. 

5. Compare outputs with ChatGPT. 

6. Use it for tasks like summarizing, answering questions, etc. 

 

Tasks Performed: 

 Asked questions related to Information Technology 

 Generated a short essay on “Importance of Education” 

 Solved simple queries and calculations 

 Generated ideas for assignments 

 Compared responses from both tools 

 

Features of AI Assistants: 

1. Natural Language Understanding 

Understands and responds to human language.  
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2. Content Generation 

Generates essays, reports, and creative content. 

3. Problem Solving 

Helps in solving academic and logical problems. 

4. Quick Response 

Provides instant answers to queries. 

5. Multi-purpose Usage 

Can be used for education, coding, writing, and more. 

 

Advantages: 

 Saves time and effort 

 Provides instant information 

 Helps in learning and research 

 Easy to use 

 Improves productivity 

 

Limitations: 

 May provide incorrect or outdated information 

 Requires internet access 

 Cannot fully replace human intelligence 

 Overdependence may reduce critical thinking 

 

Applications: 

 Education and learning 

 Content writing 

 Coding assistance 

 Research and data analysis 

 Customer support 

 



  

LAB COURSE ON IT | SNJB Chandwad Page 39 

Observation: 

 AI assistants responded quickly to queries. 

 The answers were clear and easy to understand. 

 Different tools provided slightly different responses. 

 Useful for generating ideas and completing tasks efficiently. 

 

Result: 

AI-based assistants like ChatGPT and Gemini were successfully used to perform various tasks 

such as answering questions, generating content, and problem-solving. 

 

Conclusion: 

AI assistants are powerful tools that enhance productivity and learning. They provide quick 

and accurate information and assist users in multiple tasks. However, they should be used 

wisely along with human judgment. 
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Experiment No. 11 

Title: Exploring Cloud Computing using Google Drive 

 

Aim: 

To explore cloud computing by uploading, sharing, and collaborating on documents using 

Google Drive. 

 

Theory: 

Cloud computing is a technology that allows users to store, access, and manage data over the 

internet instead of using local storage devices. It provides on-demand availability of resources 

such as storage, applications, and services. 

Google Drive is a popular cloud-based platform that allows users to store files online, access 

them from any device, and share them with others. It also supports collaboration through tools 

like Google Docs, Sheets, and Slides, enabling multiple users to work on the same document 

simultaneously. 

Cloud computing eliminates the need for physical storage devices and provides flexibility, 

scalability, and security for data management. 

 

Objectives: 

 To understand the concept of cloud computing. 

 To learn how to upload and manage files in Google Drive. 

 To explore sharing and collaboration features. 

 

Requirements: 

 Computer/Laptop/Smartphone 

 Internet connection 

 Google account 
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Procedure: 

Part A: Uploading Files 

1. Open a web browser and go to Google Drive. 

2. Sign in using your Google account. 

3. Click on New → File Upload. 

4. Select a file from your system. 

5. Wait for the upload to complete. 

6. Verify that the file appears in Drive. 

 

Part B: Creating Documents 

1. Click on New → Google Docs. 

2. Create a new document. 

3. Add text and format it. 

4. Save the document (auto-saved in Drive). 

 

Part C: Sharing Files 

1. Select a file or document. 

2. Click on the Share button. 

3. Enter the email address of another user. 

4. Set permission (Viewer/Commenter/Editor). 

5. Click Send. 

 

Part D: Collaboration 

1. Open a shared document. 

2. Invite another user to edit. 

3. Both users edit the document simultaneously. 

4. Observe real-time changes. 

5. Use comments and suggestions features. 

 

Features of Google Drive: 

1. Cloud Storage 

Stores files securely online and allows access anytime. 
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2. File Sharing 

Allows easy sharing of files with others using links or email. 

3. Real-Time Collaboration 

Multiple users can edit documents simultaneously. 

4. Automatic Saving 

Changes are saved automatically without manual saving. 

5. Accessibility 

Files can be accessed from any device with internet connection. 

6. Integration with Tools 

Works with Google Docs, Sheets, and Slides. 

 

Advantages: 

 Access files from anywhere 

 Easy sharing and collaboration 

 No need for physical storage devices 

 Automatic backup and saving 

 Secure and reliable 

 

Limitations: 

 Requires internet connection 

 Limited free storage space 

 Data privacy concerns 

 

Applications: 

 Storing personal and academic files 

 Sharing assignments and projects 

 Collaborative work in teams 

 Backup of important data 
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Observation: 

 Files were uploaded successfully. 

 Sharing was quick and easy. 

 Multiple users were able to edit documents in real time. 

 Changes were saved automatically. 

 

Result: 

Cloud computing was successfully explored using Google Drive. Files were uploaded, shared, 

and collaboratively edited. 

 

Conclusion: 

Google Drive is an effective cloud computing platform that enables easy storage, sharing, and 

collaboration of files. It improves productivity and provides flexibility in accessing data from 

anywhere. 

 

 

  

  



  

LAB COURSE ON IT | SNJB Chandwad Page 44 

Experiment No. 12 

Title: Exploring Social Media Applications and Analyzing their Features, Benefits, and 

Digital Safety Practices 

 

Aim: 

To explore different social media applications such as Facebook, Instagram, and Twitter, and 

analyze their features, benefits, and digital safety practices. 

 

Theory: 

Social media platforms are online applications that allow users to create, share, and interact 

with content and communicate with others globally. These platforms have become an essential 

part of modern communication, enabling users to connect, express ideas, and access 

information. 

Popular social media applications include Facebook, Instagram, and Twitter. Each platform 

offers unique features such as messaging, photo/video sharing, live streaming, and news 

updates. 

While social media provides many advantages, it also raises concerns related to privacy, 

security, and misuse. Therefore, understanding digital safety practices is essential for 

responsible usage. 

 

Objectives: 

 To study the features of popular social media platforms. 

 To understand the benefits of social media usage. 

 To learn digital safety practices while using social media. 

 

Requirements: 

 Computer/Laptop/Smartphone 

 Internet connection 

 Social media accounts (optional)  
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Procedure: 

1. Open a web browser or mobile apps of Facebook, Instagram, and Twitter. 

2. Log in or explore the platforms. 

3. Observe the interface and available features. 

4. Explore options like posting content, messaging, and notifications. 

5. Check privacy and security settings of each platform. 

6. Compare features and usability of different apps. 

7. Note down benefits and possible risks. 

8. Study digital safety practices followed by each platform. 

 

Features of Social Media Platforms: 

1. Facebook 

 User profiles and friend connections 

 Posting text, images, and videos 

 Groups and pages for communities 

 Messaging through Messenger 

 Live streaming 

2. Instagram 

 Photo and video sharing 

 Stories and reels feature 

 Filters and editing tools 

 Direct messaging 

 Explore section for trending content 

3. Twitter 

 Short messages (tweets) 

 Trending topics and hashtags 

 Retweets and likes 

 Real-time news updates 

 Following public figures 

 

Comparison Table: 

 

Feature Facebook Instagram Twitter 

Content Type Text, Media Photos, Videos Short Text 

Messaging Yes Yes Limited 

Popular Use Networking Media Sharing News Updates 
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Benefits of Social Media: 

 Easy communication with people worldwide 

 Sharing information and ideas 

 Educational and informative content 

 Business promotion and marketing 

 Entertainment and creativity 

 

Digital Safety Practices: 

1. Strong Passwords 

Use unique and strong passwords for accounts. 

2. Privacy Settings 

Adjust settings to control who can view posts and personal information. 

3. Avoid Sharing Personal Information 

Do not share sensitive details like address, phone number, etc. 

4. Beware of Fake Accounts 

Avoid interacting with unknown or suspicious profiles. 

5. Two-Factor Authentication 

Enable extra security for login. 

6. Report and Block 

Report inappropriate content and block harmful users. 

 

Advantages: 

 Global connectivity 

 Quick information sharing 

 Platform for creativity and expression 

 Useful for education and business 
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Limitations: 

 Privacy risks 

 Addiction and time wastage 

 Spread of misinformation 

 Cyberbullying 

 

Applications: 

 Communication and networking 

 Marketing and advertising 

 News and information sharing 

 Online learning and awareness 

 

Observation: 

 Social media platforms are user-friendly and interactive. 

 Each platform has unique features. 

 Privacy settings help protect user data. 

 Digital safety practices are important for secure usage. 

 

Result: 

Different social media platforms were explored successfully, and their features, benefits, and 

safety practices were analyzed. 

 

Conclusion: 

Social media applications are powerful tools for communication and information sharing. 

However, they must be used responsibly by following proper digital safety practices to avoid 

risks and ensure a secure online experience. 

 

 


